
INFORMATION TECHNOLOGY: THEORY AND TOOLS 

ISSN 2707-4501. Cybernetics and Computer Technologies. 2024, No.3 87 

CYBERNETICS 

and COMPUTER 

TECHNOLOGIES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Many biological objects have the ability to 

fluoresce under the influence of electromagnetic 

radiation in the optical range. Measuring the 

fluorescence of a biological object helps obtain 

information about its internal state. Therefore, 

the creation of instruments for scientific 

research in the field of studying biological 

objects has been a pressing task for many areas 

of human activity for many years. In particular, 

these are areas such as agriculture, ecology, 

food industry and medicine. This article is 

devoted to a description of the recently 

developed “FLS 10s” device for studying plant 

chlorophyll fluorescence, as well as description 

of software for operating the device and 

analyzing the information obtained. This device 

provides data of well known OJIP test.  
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FLUOROMETER “FLS 10S” 

Introduction. It is known that almost all cells have the 

property of fluorescent radiation. Currently, there are a lot 

of researches being done to explore this phenomenon and 

its possible applications. Therefore, the property of this 

process is applied in various fields of human activity. 

They are microchemistry [1–4], bioenergy [5], botany [6–

8], biology [9, 10] ecology [11–15], food industry [16], 

agriculture [17–24] etc. Website www.ScienceDirect.com 

alone includes more than 100000 articles devoted to the 

researches with applying of fluorescence measurements 

for various applications. Foremost, this is due to the fact 

that the use of fluorescence measurements allow replac-

ing expensive and time-consuming laboratory measure-

ments, and obtaining a higher quality results. 

 The aim. Despite the fact that currently there are 

many specialized fluorometers on the global market, there 

are no limits to the improvements in such devices and 

their more convenient use, which is connected with the 

development in the field of microelectronics. The goal of 

developing the fluorometer “FLS 10s” device was to cre-

ate a basic model of fluorometer for use in various fields 

of applications. The priority in creating the device was its 

application for scientific research of biological objects, in 

particular plants with applying well known OJIP test [25], 

which is often applied [6–9, 17, 21–29]. Therefore, first 

and foremost, there are agriculture and ecologic research-

es. In the future, modifying device will be able to use in 

subsequent versions for agronomists, ecologists, and edu-

cational purposes. Currently, there are many scientific 

results related to the determination of various features of 

the physiological state of plants using Fast chlorophyll α 

fluorescence induction analysis. Therefore, it makes sense 

to develop a device that would be compact, inexpensive 

and meet the modern requirements for determining the 

physiological state of plants based on obtaining the major 

parameters of the well-known Kautsky effect [30] – OJIP 

data. Obtaining OJIP data in fast induction of chlorophyll 

fluorescence is used in researching related of state plants 

under climate change, plants productivity, plant breeding, 

etc. 

https://doi.org/10.34229/2707-451X.24.3.9
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In the development of the device the possibilities of adapting the measurement process to the specific 

requirements of the user were laid down. It was provided with visualization, comparison, storage, and 

loading of previously obtained results. The implementation of the necessary analysis of research results 

creates an integrated environment for the scientific researcher for quick interpretation data, reduction of 

research terms and intensification research. One of the important features of the device is energy saving, 

which allows obtaining quality results with minimal necessary irradiation. This feature of the device 

makes no irreversible changes to the research object. FLS 10s is primarily designed to obtain data on the 

fast phase (dynamic characteristics) of fluorescent emission from plant forms, such as chloroplasts, algae, 

needles, plant leaves etc., within the first 10 seconds of irradiation. 
 

 Technical data of “FLS 10s” 

Measurement time (MT)  10 seconds 

Number of samples per MT 470 

Data resolution 12 bits 

Number of reliable bits 10 bits 

Interaction area 10 mm x 20 mm 

Energy illumination Power 120 W/m2 

Excitation spectrum at 0.5 level  460 nm – 485 nm 

The band of the measure signal at 0.5 level 600 nm – 1000 nm 

Power: @ USB in standby mode 20 mA @ 5V 

  @ USB in measurement mode 140 mA @ 5V 

Dimensions:  Long 185 mm 

   Height 65 mm 

   Width 120 mm 

Weight 433 g 
 

Appearance of the device “FLS 10s” 

Fig.1 shows the appearance of the device “FLS 10s”  

 

FIG. 1. Appearance of the device “FLS 10s” 
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 Software application for “FLS 10s” – fls_10s.exe 

General info 

 This software has been created for work with “FLS 10s” fluorometer for measurement α fluorescence 

emission of variable stage the plants. This software has been developed for Windows OS with .NET 

Framework 4.8. File name of this application is fls_10s.exe. 

Features and benefits of application 

- 4 independed windows for different measurements 

- Save .log file for future investigation 

- Open saved .log file for current investigation 

- Device auto connection or under request 

- Graphical visualization measured data up to 4 measurements 

- Graphical visualization measured data in dots or lines form 

- Save graphical visualization in to .jpg file format 

- Save measured data in .xls file format 

- Visualization of device connected and measurement process 

- Measurement time 10 seconds 

- Total measured samples 470: 

 - 10 measured samples for measurement dark and zero level 

 - Number measured fluorescence samples 460: 

  - 100 measured samples in time interval 0 – 1 ms 

  - 90 measured samples in time interval 1 ms – 10 ms 

  - 90 measured samples in time interval 10 ms – 100 ms 

  - 90 measured samples in time interval 100 ms – 1 s 

  - 90 measured samples in time interval 1 s – 10 s 

 Software general description 

 There are 8 areas in application form for management and visualization, as shown in fig. 2. 

 

FIG. 2. 8 areas of fls_10s.exe application form for management and visualization 
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Areas: 

 1 –  main menu 

 2 – indicator of current status 

 3 - visualization and management by current measurement place 

 4 – place for current measurement data 

 5 – extend Y graph display axis 

 6 – chart place for visualization measured data 

 7 – color marks for graphics in chart place 

 8 – paths to saved and opened .log files 

 Main menu (area 1) 

Main menu consist of: 

 Log File context menu for Open and Save log files 

 Set for connection to measurement device if it was been connected to PC after run    

  application program 

 Measurement for :    run measurement process 

        get last measured data 

 Chart have two sub menu:   Show Chart for visualization measured data in dots or lines 

        Save Chart or save visualization area in .jpg file 

 Data for save only measured data to .xls file 

 Indicator of current status (area 2) 

This area is for indication:    Connection measurement device 

        Measurement mode 

        Current Time of measurement process 

 Visualization and management by current measurement (area 3) 

This area is for switching between 4 measurement windows. 

Simple click to radio button for switching and select needed measurement window. 

Content of one measurement window can be visible. 

 Place for current measurement data (area 4) 

This area is for measured data which will be received from measurement device after finishing measure-

ment process. 

 Extend Y graph display axis (area 5) 

You can change visualization data in Chart area by Y axis. 

 Chart place for visualization measured data (area 6) 

This area is for visualization data which is placed in 4 measurement windows. 

Visualization data should be selected by menu Chart → Show Chart  

 Color marks for graphics in chart place (area 7) 

This is color marks for visualization data which are placed in 4 measurement windows 

(green for 1, blue for 2, gray for 3, red for 4 measurement window). 

 Paths to saved and opened .log files (area 8) 

This area is for showing paths for Saved and Opened log file corresponding to the current measurement 

window. 

 Connection 

 Note:  Current consumption “FLS 10s” device at measurement mode is about 140 mA. 

Connect your “FLS 10s” device to your PC via USB port. 

The most preferable version of USB port is USB 3. 
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 Install driver 

 Note:  The application fls_10s.exe is not work without installed of the correct driver. 

Please be sure that you have administration rights on your session. Windows 10 will install necessary 

driver automatically after connecting “FLS 10s” device if your PC is connected to the Internet. It will re-

quire some time. Please wait for appropriate notice from Windows.  

For older version Windows, driver should be installed manually. Link for downloading corresponding 

driver will be provided under request. 

 Run application 

 Run fls_10s.exe. If driver for “FLS 10s” device was installed correctly you will see it in area 2 “FLS 

connected to: COMx”. 

You will see “FLS not connected” in area 2 if appropriate driver not installed correctly. In this case you 

will not be able to use “FLS 10s” device, exit from application and install corresponding driver. 

The measurement results will be placed in area 4 depending on selected radio button. 

Measured results, placed in measurement window, have number and its time mark. 

Up to four measured results can be drawn in area 6. This feature is useful for fast comparison different 

measured data. It will help to focus attention for main differences in researches investigation. The exam-

ple of such look shown on fig. 3. 

 

FIG. 3. Example fls_10s.exe application with results of 4 different measurements 
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 Main menu functions 

 Run measurement:      Measurement → Now → Start 

 Save measured data:      Log File → Save 

 Open measured data:      Log File → Open 

 Show measured data in Chart area:   Chart → Show Chart → Chart in dots 

          Chart → Show Chart → Chart in lines 

 Save measured data in xls format:  Data → Save data in .xls format 

Results 

The "FLS 10s" device was developed for scientific studies of the fluorescent activity of biological 

objects, specifically for the study of plant chlorophyll fluorescence, providing data for the well-known 

OJIP test. One of the important features of the device is energy saving, which allows you to get high-

quality results with the minimum necessary exposure. This feature allows you not to make irreversible 

changes to the research object. FLS 10s is primarily designed to obtain data of the fast phase (dynamic 

characteristics) of the fluorescence emission of plant forms, such as chloroplasts, algae, needles, plant 

leaves..., in the first 10 seconds of exposure. 

Software application "fls_10s.exe" is designed to collect, visualize, analyze and study the obtained 

data from "FLS 10s" device. This software will save time and funds for scientists in their investigations. 

Conclusion 

“FLS 10s” device is useful for researches of: plant stress, early detection of plant and tree diseases, 

environmental stress, vegetation index, plant stress phenotyping, tree photosynthesis, fruit quality, detect-

ing of nutrient deficiency, water quality monitoring, detecting of phenolic compounds etc. 

Further development of this work will have two directions. 

The first is the addition of useful functions for analyzing the received data: such as normalization, 

averaging a data array of one type of measurement, comparing averaged data for different types of meas-

urements, calculating standard indicators of the obtained OJIP test data, etc. This improvement will create 

a research software environment that will save time and costs on research work. 

The second is to improve the technical characteristics of the device and develop various design modi-

fications for convenient use of the device for a specific type of research (for example, to study the content 

of biological objects in liquid). 
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галузі вивчення біологічних об’єктів вже багато років є актуальним завданням для багатьох сфер люд-

ської діяльності. Зокрема, це такі сфери, як сільське господарство, екологія, харчова промисловість та 

медицина. 

Дана стаття присвячена опису нещодавно розробленого приладу для дослідження флуоресценції 

хлорофілу рослин «FLS 10s», а також опису програмного забезпечення для роботи з приладом та аналізу 

отриманої інформації. Цей прилад надає дані добре відомого тесту OJIP. 

Відомо, що практично всі клітини мають властивість флуоресцентного випромінювання. На даний 

час проводиться багато досліджень, щоб вивчити це явище та його можливі застосування. Тому власти-

вість цього процесу застосовується у різних сферах людської діяльності. Це мікрохімія [1–4], біоенерге-

тика [5], ботаніка [6–8], біологія [9, 10], екологія [1–15], харчова промисловість [16], сільське господар-

ство [17–24] тощо. Тільки веб-сайт www.ScienceDirect.com містить більше 100000 статей, присвячених 

дослідженням із застосуванням флуоресцентних вимірювань для різних застосувань. В першу чергу це 

пов'язано з тим, що використання флуоресцентних вимірювань дозволяє замінити дорогі та трудомісткі 

лабораторні вимірювання та отримати більш якісні результати. 

Мета роботи. Незважаючи на те, що на даний час на світовому ринку існує багато спеціалізованих 

флуорометрів, вдосконалення таких приладів та використання їх у більш зручний спосіб, що пов'язано із 

розвитком індустрії електронних компонентів, немає меж. Метою розробки пристрою флуорометра 

«FLS 10s» було створити базову модель флуорометра для використання у різних сферах застосування. 

Пріоритетом у створенні приладу було його застосування для наукових досліджень біологічних 

об’єктів, зокрема рослин із застосуванням відомого тесту OJIP [25], який часто застосовують [6–9, 17, 

21–29]. Тому, перш за все, це дослідження в галузі сільського господарства та екології. У майбутньому 

модифікований пристрій можна буде використовувати в наступних версіях для агрономів, екологів та в 

освітніх цілях. На даний час є багато наукових результатів, пов’язаних з визначенням різноманітних 

особливостей фізіологічного стану рослин за допомогою швидкого аналізу індукції флуоресценції хло-

рофілу α . Тому має сенс розробити пристрій, який був би компактним, недорогим і відповідав би су-

часним вимогам для визначення фізіологічного стану рослин на основі отримання основних параметрів 

відомого ефекту Каутського [30] – даних OJIP. Отримання даних OJIP при швидкій індукції флуоресце-

нції хлорофілу використовується при дослідженні пов’язаних із станом рослин за змін клімату, продук-

тивністю рослин, селекцією тощо. 

Результати. Прилад "FLS 10s" розроблений для наукових досліджень флуоресцентної активності 

біологічних об'єктів, а саме для дослідження флуоресценції хлорофілу рослин, надання даних для відо-

мого тесту OJIP. Однією з важливих особливостей приладу є енергозбереження, що дозволяє отримати 

якісний результат при мінімально необхідному впливі. Ця функція дозволяє не вносити незворотні змі-

ни в об'єкт дослідження. FLS 10s в основному призначений для отримання даних про швидку фазу (ди-

намічні характеристики) випромінювання флуоресценції рослинних форм, таких як хлоропласти, водо-

рості, хвоя, листя рослин..., у перші 10 секунд експозиції. 

Програмний додаток "fls_10s.exe" призначений для збору, візуалізації, аналізу та вивчення отрима-

них даних з пристрою "FLS 10s". Це програмне забезпечення заощадить час і кошти науковців у їхніх 

дослідженнях. 

Висновок. Пристрій «FLS 10s» корисний для досліджень: стресу рослин, раннього виявлення хво-

роб рослин і дерев, екологічного стресу, індексу вегетації, фенотипування стресу рослин, фотосинтезу 

дерев, якості плодів, виявлення дефіциту поживних речовин, моніторингу якості води, виявлення фено-

льних сполук тощо. 

Подальший розвиток цієї роботи матиме два напрямки. 

По-перше, це додавання корисних функцій для аналізу отриманих даних: нормалізація, усереднен-

ня масиву даних одного типу вимірювань, порівняння усереднених даних для різних типів вимірювань, 

розрахунок стандартних показників отриманих даних тесту OJIP тощо. Удосконалення створить дослід-

ницьке програмне середовище, яке заощадить час і витрати на дослідницьку роботу. 

По друге, це покращення технічних характеристик приладу та розробка різноманітних модифікацій 

конструкції для зручності використання приладу для певного виду досліджень (наприклад, для дослі-

дження вмісту біологічних об’єктів у рідині). 

Ключові слова: флуоресценція, флуорометр, вимірювання флуоресценції, ефект Каутського, тест 

OJIP, індукція флуоресценції, швидка індукція флуоресценції хлорофілу α. 


